[bookmark: OLE_LINK1][bookmark: OLE_LINK2][image: PLC_141027_0108-1 (141217)_sRGB]––––






	








SCE Training Curriculum



Siemens Automation Cooperates with Education | 05/2016


[image: Unbenannt-1][image: Beschreibung: SIE_Logo_Layer_Petrol_RGB_A4_56mm]Additional Module 900-011
LOGO! 0BA8 Startup

Suitable SCE trainer packages to accompany these training curriculums

LOGO! Controllers
· LOGO! 8 12/24V ETHERNET – set of 6 
Order no.: 6ED1057-3SA20-0YA1
· LOGO! 8 230V ETHERNET – set of 6
Order no.: 6ED1057-3SA20-0YB1

Note that these trainer packages will be replaced with successor packages when required.
You can find an overview of the currently available SCE packages at: siemens.com/sce/tp


Further education
For further Siemens SCE education opportunities in your region, get in touch with your regional SCE contact siemens.com/sce/contact


Further information on SCE 
siemens.com/sce

Notes on use
This SCE training curriculum for the integrated automation solution Totally Integrated Automation (TIA) was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically for training purposes for public educational and R&D institutions. Siemens AG assumes no responsibility for the content.

This curriculum may be used only for initial education with respect to Siemens products/systems. That is, it may be copied in part or in whole and handed out to trainees for use within the framework of their education. Transmission and reproduction of this curriculum as well as communication of its content is permitted within public educational institutions for educational purposes. 

Exceptions require written permission from the Siemens AG contact: Roland Scheuerer roland.scheuerer@siemens.com.

Parties breaching this provision shall be liable for damages. All rights reserved, including those relating to translation and in particular those rights created as a result of a patent being granted or utility model being registered.
Use for industry customers is expressly prohibited. Commercial use of the curriculum is not permitted.

[bookmark: _GoBack]We would like to thank Michael Dziallas Engineering and all those involved for their support in creating this SCE training curriculum.
SCE Training Curriculum | Additional Module 900-011, Edition 05/2016 | Digital Factory, DF FA

For unrestricted use in educational / R&D institutions. © Siemens AG 2016. All rights reserved.	
For unrestricted use in educational / R&D institutions. © Siemens AG 2016. All rights reserved.	4		
SCE_EN_900-011_Startup_LOGO!_0BA8_R1603.docx			
Table of contents
1	Objective	5
2	Requirement	5
3	Theory	5
3.1	Information about the use of LOGO! 0BA8	5
3.2	Setting the IP address of the LOGO! 0BA8	6
3.3	LOGO!Soft Comfort V8.0	6
3.3.1	Programming interface	7
3.3.2	Project interface	8
4	Task: Factory gate control with LOGO! 0BA8	9
5	Planning	9
5.1	Technology schematic diagram	10
5.2	Reference table	11
6	Structured step-by-step instructions	12
6.1	Starting LOGO!Soft Comfort V8.0 and adding LOGO! 0BA8	12
6.2	LOGO! 0BA8 settings	14
6.3	Entering input/output names	16
6.4	Entering a program in the Diagram Editor	17
6.4.1	Inserting blocks	17
6.4.2	Aligning blocks	18
6.4.3	Setting parameters	21
6.4.4	Connecting blocks	23
6.4.5	Saving the finished circuit diagram of the gate control as a network project	23
6.5	Simulation of the circuit	24
6.6	Transferring the tested program to LOGO!	26
6.7	Online test	27
6.8	Checklist	28
7	Task: Message text	29
7.1	Task	29
7.2	Insert message texts	29
7.3	Enter message text	30
7.4	Assign backlighting of the message text	32
7.5	Simulation of the message texts	33
7.6	Online test of the message texts	34
7.7	"Message text" checklist	35
8	Displaying message texts via a Web browser	36
8.1	Activating the Web server in LOGO!	36
8.2	LOGO! in the Web browser	39
9	Additional information	41

[bookmark: _Toc442283027][bookmark: _Toc448483898]
Objective
The SCE_EN_900-011 module provides a quick introduction to the handling of LOGO! 0BA8 logic modules and programming with the LOGO!Soft Comfort V8.0 software.
[bookmark: _Toc442283028][bookmark: _Toc448483899]Requirement
Nothing is required from other chapters to successfully complete this chapter.
[bookmark: _Toc442283029][bookmark: _Toc448483900][bookmark: _Toc383196602]Theory
[bookmark: _Toc442283030][bookmark: _Toc448483901]Information about the use of LOGO! 0BA8
[bookmark: _Toc383196619]LOGO! is the universal logic module of Siemens.
The LOGO! logic module has an integrated controller with operator control and display unit. You can use the operator control and display unit of LOGO! to create and edit programs and execute system functions.
You can read in external programs from a program module via the Ethernet interface or a PC cable with the LOGO!Soft Comfort programming software. You can use LOGO!Soft Comfort not only to create a program but also to simulate your circuit on the computer and to output overview diagrams to a printer.
Depending on the device type, ready-made commonly-used basic functions, e.g. for delayed switch-on and switch-off, for current-impulse relay, time switch, and binary bit memory and for inputs and outputs, are already contained in the LOGO! logic modules.

With LOGO! you solve tasks for
home automation and installation engineering (e.g. stairway lighting, outside lighting, awnings, roller shutters, show window lighting and much more) 
manufacture of control cabinets, machines and equipment (e.g. gate controls, ventilation systems, industrial water pumps and much more)

LOGO! can also be used for special-purpose control for signal pre-processing.
When connected to AS-Interface, LOGO! can be used as distributed I/O with local intelligence for control of machines and processes. This enables the LOGO! logic module to perform control tasks and reduce the load on the master controller.

For series applications in small machine and equipment manufacturing, control cabinet manufacturing, and installation engineering, special versions without operator control unit are available. A program module or the LOGO!Soft Comfort PC software is required for downloading to these modules.
[bookmark: _Toc442283031][bookmark: _Toc442088452][bookmark: _Toc442088360][bookmark: _Toc441598462][bookmark: _Toc448483902]
Setting the IP address of the LOGO! 0BA8
[bookmark: _Toc441598463][bookmark: _Toc442088361][bookmark: _Toc442088453]With the LOGO! 0BA8 in Stop mode, navigate to the Network menu command. You can find the settings for the IP address, subnet mask and gateway here. 
Use the ► cursor or OK to enter Edit mode of the network settings. Assign the network settings according to the information from your network administrator. 
Start
Program	►
Setup	►
Network	►
Diagnostics	►
Card	►
IP – Address
Set M / S Mode




IP – Address
192.168.000.001	▼
Subnet Mask
255.255.255.000	▼
Gateway
000.000.000.000	▼
OK
OK

Note: 
In the rows with the ► or ▼ symbol, you can also navigate using the cursor key. 

[bookmark: _Toc442283033][bookmark: _Toc442088454][bookmark: _Toc442088362][bookmark: _Toc441598464][bookmark: _Toc448483903]LOGO!Soft Comfort V8.0
The software provides a completely new user interface with the following functions:
· Consistent application menu display
· New network project-based work strategy
· Split display for diagram mode and network mode
· Split display for "Standard" toolbar in the general software interface, "Tool" toolbar is displayed in diagram mode and "Network" toolbar in project mode.
· Split window display with focus switching and drag-and-drop capability
· Work on a network project enables saving, downloading, creating and closing of the network project.
· New access control settings for online access with various access possibilities
· Ability to create connections by configuring NI and NQ function blocks
· New graphic reference for the function block in the parameter field in FBD diagrams 
· Ability to configure the screen display for messages, start screen and flags with 4 lines for LOGO! devices before 0BA8 and 6 lines for LOGO! devices starting from 0BA8
· Enhanced system security by assignment of user passwords and access levels in the access control settings
[bookmark: _Toc442283034][bookmark: _Toc448483904]
Programming interface
Programming mode in LOGO!Soft Comfort starts with an empty diagram.
The majority of the screen is taken up by the user interface for creating the circuit diagram – in other words, the programming interface. The symbols and logic operations of the circuit program are arranged on this programming interface.
To help you maintain an overview of more extensive circuit programs, scroll bars are provided below and to the right of the programming interface, which can be used to scroll horizontally and vertically in the control program.

[image: ]⑤ 	Programming interface 
⑥	Status bar 
⑦ 	Diagram tree 
⑧ 	Operation tree
①	Menu bar
②	"Standard" toolbar 
③ 	Mode bar
④ 	"Tool" toolbar

[bookmark: _Toc442283035][bookmark: _Toc448483905]
Project interface
The LOGO!Soft Comfort project interface displays a network view with the devices and network connections. 
After you select "Add New Device", the Diagram Editor window appears.
Only LOGO! devices starting from 0BA7 can be programmed in a network project.
The Diagram Editor displays the program blocks and logic operations of the circuit program. The circuit program is initially empty.
To help you maintain an overview of more extensive circuit projects and programs, scroll bars are provided below and to the right of the network view and programming interface. They can be used to scroll horizontally and vertically in the control program.
[image: ]①	Menu bar
②	"Standard" toolbar 
③ 	Mode bar
④ 	"Network" toolbar
⑤ 	Network view
⑥	"Tool" toolbar
⑦	Programming interface
⑧	Status bar 
⑨	Diagram tree 
⑩	Operation tree

[bookmark: _Ref393351932][bookmark: _Toc442283036][bookmark: _Toc448483906]
Task: Factory gate control with LOGO! 0BA8
It is often possible to access a company's premises at more than one location. At each access point, it must be ensured that the gate can be opened and closed using pushbuttons directly on the gate or pull cords from the vehicle.
[bookmark: _Toc442283037][bookmark: _Toc448483907]Planning
[bookmark: _Toc431374442]A LOGO! OBA8 is used for the control.
The gate is opened or closed using a cord-operated switch. The gate is fully opened or closed in this case.
In addition, every gate can be opened and closed locally in jog mode using pushbuttons.
A flashing light is activated 5 seconds before the gate movement starts and continues during the gate movement.
A safety pressure strip ensures that no persons are injured and no objects are caught and damaged when the gate closes.
[image: ]Safety pressure strip
Warning light


[bookmark: _Toc442283038][bookmark: _Toc448483908]
Technology schematic diagram
Here you see the technology schematic diagram with the wiring for the task.

[image: ]Open gate     Close gate   Warning light

Figure 1: Technology schematic diagram
[bookmark: _Toc442283039][bookmark: _Toc431374443][bookmark: _Toc420571709][bookmark: _Toc418509624][bookmark: _Toc418368570][bookmark: _Toc448483909]
Reference table
The following signals are required for this task.
	DI
	ID
	Function
	NC/NO

	I1
	-S0
	OPEN GATE cord switch
	NO

	I2
	-S1
	CLOSE GATE cord switch
	NO

	I3
	-S2
	OPEN GATE pushbutton
	NO

	I4
	-S3
	CLOSE GATE pushbutton
	NO

	I5
	-S4
	GATE IS OPENED position switch
	NC

	I6
	-S5
	GATE IS CLOSED position switch
	NC

	I7
	-S6
	Safety pressure strip
	NC



	DO
	ID
	Function
	

	Q1
	-K1
	Contactor open gate
	

	Q1
	-K2
	Contactor close gate
	

	Q3
	-H1
	Warning light
	



Legend for reference list

	DI
	Digital input
	DO
	Digital output

	I
	Input
	Q
	Output

	NC
	Normally Closed
	
	

	NO
	Normally Open
	
	


[bookmark: _Toc442283040][bookmark: _Toc448483910]
Structured step-by-step instructions
You can find instructions on how to perform planning below. If you already have a good understanding of everything, it is sufficient to focus on the numbered steps. Otherwise, simply follow the steps of the instructions illustrated below.
[bookmark: _Toc442283041][bookmark: _Toc442088456][bookmark: _Toc442088364][bookmark: _Toc441598466][bookmark: _Toc448483911]Starting LOGO!Soft Comfort V8.0 and adding LOGO! 0BA8
Start the LOGO!Soft Comfort V8.0 software.
[image: ]
The LOGO!Soft Comfort software opens in diagram mode.
[image: neu-1]

Click the Network project tab.
[image: neu-2]
Click on "Add New Device" in the Network view.
In the device selection window, select LOGO! 0BA8.
Enter the network settings under Configuration.
Confirm your selection with OK.
[image: neu-3]
[bookmark: _Toc442283042][bookmark: _Toc442088457][bookmark: _Toc442088365][bookmark: _Toc441598467][bookmark: _Toc448483912]
LOGO! 0BA8 settings
Open the LOGO! settings by double-clicking on Settings.
[image: neu-5]
All offline/online settings of LOGO! 0BA8 can be edited here.
[image: neu-6]

I/O settings for the configuration of the analog terminals.
[image: neu-7]
I/O names for designating the input and output terminals.
[image: neu-8]
Close the LOGO! settings window with OK.
[bookmark: _Toc442283043][bookmark: _Toc442088458][bookmark: _Toc442088366][bookmark: _Toc441598468][bookmark: _Toc448483913]
Entering input/output names
You can also open the I/O names window via the Edit menu.
[image: neu-9] 
Enter the I/O names of the factory gate control and close the window with OK.
[image: neu-10]
[bookmark: _Toc442283044][bookmark: _Toc442088459][bookmark: _Toc442088367][bookmark: _Toc441598469][bookmark: _Toc448483914]
Entering a program in the Diagram Editor
[bookmark: _Toc442283045][bookmark: _Toc448483915]Inserting blocks
Minimize the network view. Right-click the name of the diagram and select "Rename". Then change the name to gate_control.
[image: neu-12]
Using drag-and-drop, move 7 inputs to the programming interface and place them in the following order from top to bottom: I1, I3, I5, I2, I4, I6 and I7.
[image: neu-14]
[bookmark: _Toc442283046][bookmark: _Toc448483916]
Aligning blocks
Select the inserted inputs using Ctrl+click.
Click the Align vertically button.
[image: neu-15]  	  [image: neu-16]

Click the Space vertically button and enter 50 for the distance value.
Confirm with OK.
[image: neu-17]


Move the Q1, Q2 and Q3 outputs to the programming interface using drag-and-drop.
Select the inserted outputs using Ctrl+click. 
Click the Align vertically button.
Click the Space vertically button.
Enter 200 for the distance value. 
Confirm with OK.
[image: neu-18]
[bookmark: _Toc442283047][bookmark: _Toc448483917]
Setting parameters
Using drag-and-drop, place an On-delay in front of output Q1.
Double-click on B001 (On-delay) and set the time to 5 seconds.

[image: neu-19]


The block functions in the programming interface can be shown using buttons.
[image: neu-20]

Place the remaining blocks B002 to B016 and set the times for B007 and B016.
[image: neu-22]
[bookmark: _Toc442283048][bookmark: _Toc448483918]
Connecting blocks
To complete the circuit, the individual blocks still have to be connected to one another. For this purpose, select the [image: ] button for the block connection in the Tool toolbar.
[image: neu-21]
[bookmark: _Toc442283049][bookmark: _Toc448483919]Saving the finished circuit diagram of the gate control as a network project
To save, click the diskette button [image: ] and enter gate_control for the file name.
[image: ]
[bookmark: _Toc442283050][bookmark: _Toc442088460][bookmark: _Toc442088368][bookmark: _Toc441598470][bookmark: _Toc448483920]
Simulation of the circuit
Program simulation allows you to test a circuit program and change its parameter assignment. In this way you can ensure that you transfer a functional and optimized circuit program to your LOGO!
The input signals should be preset for the simulation. Double-click on input I1.
Go to the Simulation tab and select Momentary pushbutton (make).
Also set inputs I2, I3 and I4 to Momentary pushbutton (make) under Simulation.

[image: neu-24] 
Double-click on input I5.
Go the Simulation tab and select the Momentary pushbutton (break).
Also set inputs I6 and I7 to Momentary pushbutton (break) under Simulation.

[image: neu-25]
Save your circuit diagram.

To start the simulation, click the simulation button [image: neu-29] in the Tool toolbar. You are then in simulation mode.
[image: neu-35]

[bookmark: _Toc442283051][bookmark: _Toc442088461][bookmark: _Toc442088369][bookmark: _Toc441598471][bookmark: _Toc448483921]
Transferring the tested program to LOGO!
Once you have tested your program with LOGO!Soft Comfort simulation, you can transfer it from PC -> LOGO! with the [image: neu-32] button. 
Click the Refresh button [image: neu-36] to display the accessible LOGO! devices.
[image: neu-28]
Confirm the next window with OK or Yes.
[bookmark: _Toc441598472][bookmark: _Toc442088370][bookmark: _Toc442088462][image: neu-29]
[image: neu-30]
[image: neu-31]
[bookmark: _Toc448483922]
Online test
With the online test button [image: neu-33], the circuit program can be tested in connection with the LOGO!. The states of the inputs and outputs and logic operations are displayed. 
Click the Online test button [image: neu-33] to start monitoring.
[image: neu-32]

[bookmark: _Toc442283053][bookmark: _Toc448483923]
Checklist
	No.
	Description
	Completed

	1
	Project created
	

	2
	LOGO! controller detected and entered in the project
	

	3
	Successful download of the program to the LOGO! without error message
	

	4
	Actuate open gate cord switch (I1 = 1), warning light flashes  Q3 = 0-1-0-1
	

	5
	After 5 s, the gate opens (I6 = 1) Q1 = 1 
	

	6
	Gate is opened (I5 = 0)  Q1 = 0, Q3 = 0
	

	7
	Actuate close gate cord switch (I2 = 1), warning light flashes  Q3 = 0-1-0-1
	

	8
	After 5 s, the gate closes (I5 = 1) Q2 = 1
	

	9
	Gate is closed (I6 = 0)  Q2 = 0, Q3 = 0
	

	10
	Actuate open gate pushbutton (I3 = 1), warning light flashes  Q3 = 0-1-0-1
	

	11
	After 5 s, the gate opens (I6 = 1) Q1 = 1
	

	12
	Release open gate pushbutton (I3 = 0)  Q1 = 0, Q3 = 0
	

	13
	Actuate pushbutton close gate (I4 = 1), warning light flashes  Q3 = 0-1-0-1
	

	14
	After 5 s, the gate closes (I5 = 1) Q2 = 1
	

	15
	Release close gate pushbutton (I4 = 0)  Q2 = 0, Q3 = 0
	

	16
	Actuate close gate cord switch (I2 = 1), warning light flashes  Q3 = 0-1-0-1
	

	17
	After 5 s, the gate closes (I5 = 1) Q2 = 1
	

	18
	Actuate safety strip (I7 = 0)
	

	19
	Gate stops  Q2 = 0, Q3 = 0
	

	20
	Actuate pushbutton close gate (I4 = 1), warning light flashes  Q3 = 0-1-0-1
	

	21
	After 5 s, the gate closes (I5 = 1) Q2 = 1
	

	22
	Actuate safety strip (I7 = 0)
	

	23
	Gate stops  Q2 = 0, Q3 = 0
	


[bookmark: _Toc448483924][bookmark: _Toc442283054]
Task: Message text
[bookmark: _Toc420571096][bookmark: _Toc448483925]Task
In this task, you expand the gate control program to include a message text function. The expanded diagram is to be planned, programmed and tested. In addition, the status of the gate will be displayed on the LOGO! display. In order for the message text to also be displayed via a Web browser, the Web browser is selected as an additional message destination.
[bookmark: _Toc448483926]Insert message texts
You can use drag-and-drop to move message texts under Miscellaneous to the diagram and interconnect them.
Move two message texts to the programming interface.
Interconnect the message texts with input I6 (gate is closed NC)
Negate the interconnection at block B017.
[image: neu-36]
Note:
The message text in the block: 
· B017 is displayed when the gate is closed.
· In contrast, B018 appears when the gate is open.
[bookmark: _Toc448483927]
Enter message text
Double-click on message text block B017. The window for parameter assignment of the message text opens.
Each message text has a priority. If multiple message texts are pending, the text with the higher priority is always displayed.
Select LOGO! display and Web server as message destinations.
Enter gate closed as the message text.
Click OK to close the window.
[image: neu-37]


Double-click on message text block B018. The window for parameter assignment of the message text opens.
Select LOGO! display and Web server as message destinations.
Enter gate open as the message text.
Click OK to close the window.
[image: neu-38]
Note: 
Information on further use of message texts can be found in the online help.
[bookmark: _Toc448483928]
Assign backlighting of the message text
Backlighting on the LOGO! display can be specified using flags.
[image: neu-39]
Set flag 25 for white backlighting after the message text (B017) and flag 28 for yellow backlighting after the message text (B018).
[image: neu-40]

Note:
The output of the message text block must be interconnected. Alternatively, you can also interconnect an open terminal here.
[bookmark: _Toc448483929]
Simulation of the message texts
To start the simulation, click the simulation [image: neu-29] icon in the Tool toolbar. You are then in simulation mode.
[image: neu-41]
[image: neu-42]
[bookmark: _Toc448483930]
Online test of the message texts
You can use the Adjust message text button [image: neu-51] to show the message text of the 
LOGO! display in the view.
[image: neu-43]

[image: neu-44]
[bookmark: _Toc448483931][bookmark: _Toc420571100]
"Message text" checklist
	No.
	Description
	Completed

	1
	Project created
	

	2
	LOGO! controller detected and entered in the project
	

	3
	Successful download of the program to the LOGO! without error message
	

	4
	Message text on LOGO! display "Gate closed" with white background
	

	5
	Actuate open gate cord switch (I1 = 1), warning light flashes  Q3 = 0-1-0-1
	

	6
	After 5 s, the gate opens (I6 = 1) Q1 = 1 
	

	7
	Message text on LOGO! display "Gate open" with yellow background
	

	8
	Gate is opened (I5 = 0)  Q1 = 0, Q3 = 0
	

	9
	Actuate close gate cord switch (I2 = 1), warning light flashes  Q3 = 0-1-0-1
	

	10
	After 5 s, the gate closes (I5 = 1) Q2 = 1
	

	11
	Gate is closed (I6 = 0)  Q2 = 0, Q3 = 0
	

	12
	Message text on LOGO! display "Gate closed" with white background
	

	13
	Actuate open gate pushbutton (I3 = 1), warning light flashes  Q3 = 0-1-0-1
	

	14
	After 5 s, the gate opens (I6 = 1) Q1 = 1
	

	15
	Message text on LOGO! display "Gate open" with yellow background
	

	16
	Release open gate pushbutton (I3 = 0)  Q1 = 0, Q3 = 0
	

	17
	Actuate pushbutton close gate (I4 = 1), warning light flashes  Q3 = 0-1-0-1
	

	18
	After 5 s, the gate closes (I5 = 1) Q2 = 1
	

	19
	Release close gate pushbutton (I4 = 0)  Q2 = 0, Q3 = 0
	

	20
	Actuate close gate cord switch (I2 = 1), warning light flashes  Q3 = 0-1-0-1
	

	21
	After 5 s, the gate closes (I5 = 1) Q2 = 1
	

	22
	Actuate safety strip (I7 = 0)
	

	23
	Gate stops  Q2 = 0, Q3 = 0
	

	24
	Actuate pushbutton close gate (I4 = 1), warning light flashes  Q3 = 0-1-0-1
	

	25
	After 5 s, the gate closes (I5 = 1) Q2 = 1
	

	26
	Actuate safety strip (I7 = 0)
	

	27
	Gate stops  Q2 = 0, Q3 = 0
	



[bookmark: _Toc448483932]
Displaying message texts via a Web browser
[bookmark: _Toc448483933]Activating the Web server in LOGO!
To display message texts of the LOGO! via a Web browser, the Web server must first be activated in the online settings of LOGO!.
Double-click on Settings in the network project.
Select the Online Settings tab in the LOGO! settings window.
[image: neu-45]
Click Connect to activate the online settings of LOGO!.
[image: neu-46]

Click on Access control settings.
Confirm the change to STOP mode.
[image: neu-47]
Select the Allow Web server access check box and click Apply.
[image: neu-48]

The Web server is activated and the LOGO! changes back to RUN mode.
Confirm the change to RUN mode.
[image: neu-49]
Click OK to close the LOGO! settings window.

[bookmark: _Toc448483934]
LOGO! in the Web browser
Start Internet Explorer and enter the IP address of the LOGO!.
[image: neu-50]
Set the language to English and click "Log on".

[image: neu-51]


Click on LOGO! BM to show the LOGO! display in the Web browser.
[image: neu-52]


[image: neu-53]
Note: 
Information on further use of the Web view can be found in the online help.

[bookmark: _Toc448483935]
Additional information

In the "Instructions" folder of this training curriculum 900-011, you can find additional information on programming and handling of LOGO!, such as online help, LOGO! product manual and LOGO! presentations. See link below.
You can also find a helpful collection of links such as: LOGO! Web Based Training, Getting Started, Videos, Tutorials, Apps, Manuals, Programming Guidelines and Trial Software/Firmware, at the following link :

www.siemens.com/sce/logo
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